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System Requirements for Medical Dispatch 4 
Server Requirements (minimum) 
*Windows XP Professional, Vista Business, Vista Ultimate, Vista Enterprise, or 

Server2003 
AND 
*MS SQL SERVER 2005 
WITH 
*500MB Available Hard Disk Space 
*1GB RAM 
*Internet Connection 
 
Workstation Requirements (minimum) 
*Windows XP Professional, Vista Business, Vista Ultimate, or Vista Enterprise 
AND 
*200MB Available Hard Disk Space  
*512MB RAM
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LAYOUT OF WINDOWS 
 
Window Manipulation 
Users are able to customize their windows to show different windows.  Five windows are 
available for users to modify in ways to maximize their needs.  Windows are able to be 
shown or hidden, maximized, or snapped into places. 
Available windows are: 
 -Calls (Transports) 
 -Trip Calendar 
 -Inservice Units 
 -Unit Scheduler 
 -Selected Call Info 
 
There must be at least one window visible at all times. 
 
Users can click the top of each window and drag it into various postions.  When being 
dragged to an appropriate position, the window will show a gray outlined box of where it 
will snap to.  If in the gray box is not shown, it is unable to be snapped in that position.  If 
the window is left there, it will be a free-floating window. 
 
Windows are also able to shown in a tab-like format.  Simply drag the new window over 
the current window until the gray box appears.  The gray box will show the tabbed 
outline. 
 
To remove a window, click the Red X in the top right of the window.  If the window is in 
a tabbed view, users must click the window and drag it out of the tabbed view so that the 
red X will appear.  Click the red X to remove the window. 
 
FIELDS 
 
TASKS 

CALENDAR:   
Starting from the top left, users are able to select the Calendar.  This enables users 
to look for future schedule Calls. 

 
NEW CALL: 
This selection allows the user to input a new non-emergency call for a patient 
transfer.  The user can also access this quickly by using the keyboard shortcut F2. 

 
QUICK CALL: 
This selection allows the user to input a new emergency call for a patient transfer.  
The user can also access this quickly by using a keyboard shortcut CTRL-F2. 

 
NEW WINDOWS 
 TRIP CALENDAR 
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Users can utilize this selection to view scheduled calls for any particular day. 
  

CALLS 
This selection shows the calls for the selected day.  Dispatchers are able to 
perform the necessary tasks to dispatch and cancel any pending calls from this 
screen. (This is the bottom half of the screen shot titled “Home Screen”). 
 
INSERVICE UNITS 
Inservice Units enable users to control the units of the company.  Users are able to 
“activate” or “deactivate” units as needed.  (This is the top left window in the 
“Home Screen”.)  Optional: Units are able to be paged via the paging system via 
the Inservice Units screen.  To do this, simply highlight the unit needing to be 
paged and click the Page button at the top of the window.  Complete the form as 
necessary and send the page. 
 
SCHEDULED UNITS 
Scheduled Units allow the users of Medical Dispatch to view the Units currently 
scheduled and what they are scheduled for. 
 
SELECTED CALL INFO 
Selected Call Info is the screen that displays the details of a call that is selected 
from the CALLS window.  (This is the top right window of the “Home Screen”.) 
 

Tools 
UNIT SCHEDULER 
The Unit Scheduler allows users to schedule units and crew.  This is an 
administrator option only. 
 
SEARCH 
The Search window allows users of Medical Dispatch to search for a specific call.  
There are multiple fields to search from. 
 
REPETITIVE TRANSPORT MANAGER 
The repetitive Transport Manager enables users to “Push” repeat calls.  The repeat 
call is first created via the New Call option.  Users then search for that repeat call 
and “Push” the trips through the scheduling system.  This automatically schedules 
the repeat trips. This is an administrator option only. 
 
MD4 CONFIGURATION 
MD4 Configuration allows managers to configure the program.  This is where 
settings for Paging, StatusTRAK, Medical Necessity, License, etc are set.  This is 
an administrator option only. 
 
DATABASE ADMINISTRATOR 
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Database Administrator allows managers to add records to the database.  Records 
could be Dr’s Offices, Names, Hospitals, Units, Dialysis Centers, etc.  This is an 
administrator option only. 
 
USER MANAGER 
User Manager enables managers to administrate user accounts of the Medical 
Dispatch system.  This is a manager options only. 
 
PAGER (optional) 
Pager allows pagers to be added to the system and groups to be added and edited 
in the system as well.  Pagers can either be assigned to an employee or a unit.  
Groups can be added to the system as well.  This is an administrator option only. 
 
REPORT DESIGNER 
Report Designer allows users to easily create custom reports using the Fast 
Reports system.  This is an administrator option only. 
 
EXPORT (optional) 
Export enables the system to export the trips so that they can be billed for.  
Managers are able to set up the system with certain billing software titles to 
automatically bill for calls as they are completed.   
 
STATUSTRAK (optional) 
StatusTRAK, when purchased with Medical Dispatch, enables dispatchers to 
track the location of the units in real time via purchased Global Positioning 
equipment. 

 
 
WINDOWS 
 
CALLS/TRANSPORTS WINDOW 
This window is likely to be the most commonly used feature for dispatchers.  For this 
reason, it is highly customizable.   
 
Columns can be removed or added.  Columns can also be stretched or squeezed.  

 
To add a column, click the top left button in the menu bar.  It will 
drop a list down that can be selected from.  Many fields that are 
reported about a call can be shown via this method.  Place a 
check mark in the box to the left of the field to show it as a 
column.  Likewise, remove a checkmark to remove a field from 
view.   
 
Note the if you click a column and drag it into the window area, 
you will see a black ‘X’ in it.  If let go in this position, it will 
remove the column from the window entirely.  See the screenshot 
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below. 
 
 
To manipulate a column, click the right side of the 
column (where the mouse pointer changes) and drag 
it in or out as needed. 
 
Columns are also able to be filtered.  An example 
would be to show only calls being transported to A
Hospital.  Click the destination column and a list of 

destinations will appear.  Select ABC Hospital.  Now only calls going to ABC Hospita
will be shown.  NOTE: To view all calls, simply click the filtered menu (Destinati
this example) and click ALL.   

BC 

l 
ons in 

 
The calls window can be adjusted to show calls ahead and back of the current system 
time.  Simply RIGHT CLICK in any available white area and click FILTER.  Set the 
number of hours ahead to see and the number of hours behind the current time.  Click 
SAVE to apply the settings or click CANCEL to return to the main window without 
saving.  
 
Tools 
The only available options for non-administrator accounts under Tools is “Search, 
StatusTRAK (if purchased), and Export (if purchased). 
 
Search allows users to define fields similar to the CALLS Window but with an expanded 
date range.  The results are also able to be printed.   
 
Administrator User options include Unit Scheduler, Repetitive Transport Manager, MD4 
Configuration, Database Administrator, User Manager, Report Designer.   
 
Database Administrator 
Proper Database Maintenance:  The Database Manager allows users to edit, enter, and 
delete numerous frequently used items.  It is highly recommended to not delete any items 
from the databases.  This helps keep data integrity.  For Example, if you delete Insurance 
company XYZ and later add them back, it may affect your ability to run reports on 
patients with XYZ Insurance due to having two entries in the database at different times.  
Further, if XYZ insurance changes its name, it should be edited to its new name.  This 
allows the report feature to run as expected.  Note that editing any data here will not 
affect previously entered calls.   
 
Tables 
 Call Priority – The Call Priority table holds the names and levels of priorities 
given to calls.  Levels are relative, a higher level is a higher priority.  Level zero will be 
seen as a call on hold.  Level one is a regular priority.  Two or greater is considered 
elevated. 
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 Call Types – Call Types allow you to categorize calls.  The ability to schedule a 
return trip may be enabled or disabled based on call type. 
  
 Companies – The Company table holds your list of companies. 
 
 FIPS Codes – FIPS Codes table holds minor geographic areas, and their 
corresponding FIPS code used in government information systems.  The data in this table 
usually will be imported from an official data source rather than edited directly.   
 
 Insurance – The Insurance table holds the list of insurance payors. 
 
 Location Categories – The Location Category table holds the names of the 
categories you may place locations in for grouping and reporting purposes.  In example, 
there are Dialysis Centers, Doctors Offices, Hospitals, etc. 
 
 Locations – The Location table is your dispatch center’s address book. It contains 
the name and address of the facilities you frequent, saving having to reenter the 
information on each call.  If selecting the location type ‘Generic’, it will not require 
pertinent fields such as the specific address. 
 
 Patients – The Patient table is the master list of patient records.  Information will 
be copied from here when creating a new call. 
 
 Persons – The Person table holds your list of employees who staff vehicles. 
 
 Response Modes – Response Modes indicate how a unit responded to a call, or 
transported a patient. 
 
 Service Areas – The Service Area table holds descriptive names for geographic 
areas defined by you.  Locations belong to a Service Area. 
 
 Service Levels – Service Level indicates the maximum level of service a vehicle 
may provide.  An Example would be that a BLS unit cannot perform the duties of an ALS 
call.  However, an ALS unit can perform the necessary functions of a BLS call. 
 
 Skill Levels – Skill Levels (or certifications) indicate which persons may fill roles 
on a unit. 
 
 Transport Codes – Transport Codes are predefined reason’s for transport. 
 
 Vehicles – The vehicle table holds your list of transport vehicles. 
 
MD4 Configuration 
MD4 Configuration is a utility in which managers can edit some of the key features of 
Medical Dispatch 4.  Other than editing license information, managers can enable trucks 
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to be dispatched on more than one call at a time, enable Medical Necessity and make it 
required or even optional, edit field names, Paging, and StatusTRAK.   
 
License – This is where a company can edit their registration information.  Note that this 
should never be edited without contacting Med-Media Technical Support first. 
 
Call Options 
Field Labels – This is where the field labels (listed at the top of the Call Window) can be 
edited. 
  
Call Numbers – Call number formatting can be edited here.  Note that it can be 
configured to assign call numbers at different points in the progress of a call.  Options 
include: At first keypress, When saving, When dispatched, When responding.  Further, 
Call Numbers can be keyed by either the Call Date or Current Date.  The formatting can 
be edited at the bottom of the form.  Drop the Key Format box down to select from either 
YYYY, YY, YYMM, or YYMMDD.  Edit the Digits field to provide the suffix portion  
of the Call Number.  Digits can range from 3-9.  Be aware when choosing the format so 
that the system has enough calls to assign for your company needs.   
 
Medical Necessity – Medical Necessity can be enabled or disabled in this field.  Further, 
if enabled, Medical Necessity can be either allowed or disallowed for editing.  If “Make 
Questions Optional” is checked, any Medical Necessity field can be left blank for the call 
to be completed. 
 
Repetitive Transports 
Repetitive transports can enabled for all users.  Typically, this is a manager only option 
by default. 
  
Server Options –Transports can be scheduled in advanced by up to 1 year.  Default is 60 
days.  To be able to “Push” the calls to the server via Repetitive Transport Manager, the 
option “Enable Server Side Scheduling” MUST be checked.  The email address field is 
for a future purpose only. 
 
Paging 
Reg. Key is a field that should only be editing after contacting Med-Media Technical 
Support.  If an email address is entered in the Return Address field, any pages that are 
undeliverable will be returned to this address.  This helps in awareness if your paging 
service is having technical problems.   
 
Mapping 
Reg. Key is a field that should only be editing after contacting Med-Media Technical 
Support.  Under StatusTRAK, enter your iTrak login information.  Polling Interval 
should not be set to less than 30 seconds.  iTrak requires their written approval for polling 
intervals to be less than 30 seconds. 
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Search 
The search feature is a powerful tool similar to that of a report.  Columns are able to be 
removed or selected in the same manner as the Call Window.  If the far left button in the 
Column Title bar, the columns can be selected or deselected. Columns can also be filtered 
upon by clicking the title of the column. 
 
To Run a Search 
Select a start date and end date and click refresh.  The results will appear below.  You can 
click the chart tab to graph your results in various chart types.  Click the chart tab and 
then click the chart type in the far right of the window.  By default this is Column 
Diagram.  Select from the list of other chart types for the display.   
 
After getting the results desired, users can view the print preview by selecting Preview 
Results.  If desired to print the results immediately, simply click Print Results. 
 
Unit Scheduler 
Unit scheduler is where units are scheduled.  When scheduling a unit, enter the times that 
the unit should be scheduled.  In the next window, select the Unit to be scheduled.  Select 
the Service Level.  Note that the Service Level selection alters which level of Providers 
need to be scheduled for the unit.  These requirements can be edited in the Database 
Manager>Service Levels. 
 
NOTE: If an asterisk (*) is next to the Unit or Person, they are already scheduled at some 
point throughout this new shift.  Please adjust accordingly. 
 
To cancel a unit, simply highlight the unit to be cancelled and click Cancel Unit.   
 
Note the calendar in the top right of the Unit Scheduler window.  If the date is in BOLD, 
there is at least one unit scheduled for that date.  
 
Repetitive Transport Manager 
After a call is entered using the repeat function, it needs to be pushed through using the 
Repetitive Transport Manager.  Pushing the call is the same as scheduling all of the future 
calls.  If the call is in as a repeat call, it will display here.  To schedule the calls, select the 
call.  Select the date that the calls should be scheduled through.  Click Push to have the 
system automatically schedule every call from now through the date selected.   
 
Likewise, if a person no longer needs transports due to change in situation (death, no 
longer a customer, etc), simply edit the repeat calls.  Remove the check marks for the 
days that the person is scheduled (i.e. Monday, Wednesday, Friday) and Push it through.  
The system will then unschedule the remaining trips. 
 
 
User Manager 
Select User Manager from Tools menu.  
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Select New to create new user; select Edit to edit user names and permissions. When User 
window appears create/edit user in the User tab. Select user group in Group Membership 
tab. 
 

 To grant administrator rights 
to the user select Grant 
Administrator level access to 
this user in Permissions tab. 
Click Save to save your 
settings or click Cancel to 
exit without saving. 
 
Administrator rights will 
allow user to make any 
changes to database and 
configurations of MD4. 
 
To create/edit group select 
New to create new group; 
select Edit to edit group 
names and permissions. 

When Group window appears (almost same as User window) create/edit group in the 
User tab. Select members of the group in the Group Membership tab. To grant 
administrator rights to the users of the group select Grant Administrator level access to 
this group in Permissions tab. Click Save to save your settings or click Cancel to exit 
without saving.   
 
Paging 
Setting up paging is extremely simple.  First, login as an administrator to Medical 
Dispatch.  Choose Paging from the left menu.  Note that this option only shows up if you 
have purchased the paging module from Med-Media.   
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Adding a Pager 
To add a Pager, click New Pager.  Enter a Name for the pager in the Name field.  
Generally, this is the employee name or the rig that the pager is assigned to.   
 
Next, enter the email address of the pager.  Typically this is in the format of 
XXXXXXXXXX@YYYYY.MMM where the X’s represent the 10 digit pager number, 
Y’s represent the domain of the paging company (att, vtext, etc.) and the M’s represent 
either COM or NET.  An example pager email address would be 7175558200@vtext.net.  
If you are unsure as to what your email address would be for the pager, please contact 
your Pager Service Provider.  Med-Media Technical Support will not know what your 
correct Pager Email Address is. 
 
Finally, Choose what you want the pager assigned to.  Choices are Other, Employee, or 
Vehicle.  When choosing Employee, Select Employee and then click the drop down 
menu for an employee list to select from.  If choosing a Vehicle, click the Vehicle radio 
button and then click the drop down menu to select the Vehicle.  Lastly, click Save to 
save the pager or Cancel to cancel the addition and return. 
 
Editing a Pager 
To edit a pager, select it from the list and then click Edit Pager.  Make changes as needed 
and click Save to save the pager changes or click Cancel to cancel the changes and return 
to the Pager Window. 
 
Pager Groups 
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To add, edit, or delete pager groups, first click the Pager Groups tab.  To add a group, 
click New Group.  To edit a group, select the group from the window first, then click Edit 
Group from the left side menu.   
 
Adding groups and editing them are similar and simple.  When adding a group, first, give 
the group a name.  Click the Group Members tab and place a check mark in the boxes 
next to the pagers for the pagers you want added to this group.  Similarly, when editing a 
group, to remove members, remove the check next to the members you want removed by 
clicking the check box.   
 
Save any changes by clicking Save or cancel changes by clicking Cancel. 
 
To delete a group, select the group from the list and click Delete Group. 
 
 
Export 
The export feature, when purchased from Med-Media, enables the system to export trip 
data for billing.  Exports can be done manually, or with the proper setup, can be done 
automatically when calls are completed.   
 
For manual exports, simply click the Export button from the left Tools menu.  Set the 
first date and the last date.  Select the type of output file next.  Options for this include 
Native CSV, Sweet Billing, and AIM Billing.  The file will be created and saved to the 
file path specified when you click Start.  To cancel, click Cancel.   
 
To change the output path, click File>Configure Path for Current File.  Make the change 
and click OK or cancel. 
 
Setting up Data Exchange 
Data Exchange is the automated export system for billing in Medical Dispatch.  To set 
this option, click File>Configure Data Exchange.   
 
Place a check in the checkbox that says Data Exchange Enabled.  In the Data Path field, 
either browse to the data path or type in the path manually that you wish to have the 
export go to.   
 
***Note for AIM Billing with the import module, this path should be the AIM WinData 
Path\Import*** 
 
Select the file type next.  Click OK to save changes or Cancel to cancel. 
 
 
StatusTRAK 
StatusTRAK is the add-on module to Medical Dispatch that when purchased with a 
qualifying service provided by iTrak, provides live GPS assisted tracking of the vehicles.   
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Reports 
Creating reports in Medical Dispatch 4 now features a report wizard option.   
Follow the following steps to start a report: 
 
-Click Report Designer from the left side Tools menu 
-Click File>New>Standard Report Wizard 
-Select the dataset if populated, otherwise, click New Table 
-Under Choose Connection Type, select ADO Table.   
-For Choose the Table Name, select dbo.mdCall. 
-Click OK 
-Click Next 
-Select and add the fields desired. 
-Arrange the field if desired by selecting the field in the right column and click the 
up/down arrows as desired. 
-Click Next 
-Click Next through the final few tabs by choosing the options desired 
-Click Finish 
 
You can save your report by clicking File>Save As.  Be sure to save the report in the 
Custom folder so that it can be easily brought up via Medical Dispatch.   
 
To preview your report, click File>Preview. 
 
Some reports called Canned Reports have already been generated for you.  These reports 
are accessible from the Reports menu in the main Medical Dispatch window. 
 
Creating a New Call 
First, for a regular New Call, select New Call or hit F2 on your keyboard.  For an 
Emergency New Call, click Quick Call or hit CTRL-F2 on your keyboard. 
 
This will open up a new window.  Please notice the differences between the call 
windows. 

 
New Call Window   New Quick Call Window 
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The regular call window has blue subject bars.  The Quick call has red subject bars in it. 
 
The current selected or focused field shades in a yellow color, helping users to quickly 
identify where they are in the call. 
 
To select a patient that already 
exists, click the Patient Button “…” 
as shown here:  
 
 
 
 
 
 
 
 
 
Next, Type in the search 
criteria, in this example we 
used the first few letters of the 
last name. (See Red Box 1) 
 
Next, select the appropriate 
person (See Red Box 2) 
 
Finally, Click “Select Patient” 
from the bottom of the screen.  
(See Red Box 3). 
 
 
 
 
 
 
 
 
 
 
 
Regardless of which type of new call the user selects, they have required fields that they 
must fill in prior to saving the call.  The required fields are shaded in red.  Please note 
that the required fields may change depending on the users selections while entering a 
new call. 
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Once the call is saved, it gets queued up for the day it is entered for.  Dispatchers will 
then be able to see it in their Call window for the day of the transfer.   
 
How to Dispatch a Call 
Dispatching a call in Medical Dispatch is as easy as a few clicks.  

 
In the Transports window, Select the call that needs dispatched, Assign it to a unit by 
clicking the Assign button. 
 
Going down the line, if you click the Dispatched button, it will send a page at to the crew 
(with the optional paging module).   
 
The next buttons you have are the En route to Scene, Arrived at Scene, En Route to 
Destination, and Arrived at Destination.  By simply clicking on the button, it will input 
the current system time in for the call. 
 
Finally, it is important that the call be cleared by clicking the Cleared Destination button.  
This releases the crew so that they will be able to be assigned another call.  The call will 
then also disappear from the Transports window. 
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Contacting Med-Media Technical Support 
 
Support Hours (Mon-Fri): 
 Core/Engineering: 9:00AM-5:00PM EST 
 Extended Live Support: 8:00AM-12:00AM (Mid.) EST 
 Emergency Support Available 24/7 
 
Phone 
 717-657-8200, Option 1 
 
Email 
 techsupport@med-media.com 
 
Online 
 http://www.med-media.com/support/index.shtml  then click Online Chat Support 
 
Mailing Address 
 Med-Media, Inc. 

6301 Grayson Road - MS 113 
Harrisburg, PA 17111 
 

Office Location 
 4930 Ritter Road 

Suite 101 
Mechanicsburg, PA 17055 
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Med-Media, INC. Software Product License Agreement and Limited 
Warranty 
_____________________________________________________________________ 
You should carefully read the following terms and condition before using this software. Unless you have a 
different license agreement signed by Med Media, Inc. a Delaware corporation (hereinafter "Med-Media") 
your use of this software known as Medical Dispatch (the "Software") indicates your acceptance of this license 
agreement and warranty. 
 
Binding Agreement. The right to use this Software is sold only on condition that you agree to the 
following license terms. If you do not agree with the terms of this Binding Agreement, you should return 
the Software to Med-Media within five (5) days of your receipt of this agreement. Your failure to return the 
Software indicates your consent to the terms hereof. 
This is a legal agreement (AGREEMENT) between you, the recipient of the software and Med-Media. 
BY DOWNLOADING, INSTALLING, COPYING OR OTHERWISE USING THE ATTACHED CLIENT 
SOFTWARE, YOU ARE INDICATING THAT YOU ARE AUTHORIZED TO BIND THE LICENSED USER 
IN CONTRACT AND THAT THE LICENSED USER ACCEPTS THE TERMS OF THIS AGREEMENT. IF 
YOU, AS THE LICENSED USER OR REPRESENTATIVE OF THE LICENSED USER DO NOT AGREE 
TO THE TERMS OF THIS AGREEMENT, DO NOT DOWNLOAD, INSTALL, COPY OR OTHERWISE 
USE THE CLIENT SOFTWARE. 
 
GRANT OF LICENSE: This Med-Media product contains software ("Client Software") that allows a 
computer to access or utilize the services provided by a computer called a Server. Access to the Server 
by this Client Software is only done through the purchase and upkeep of a WebCUR Client Access 
License ("CAL"). A CAL provides you with one Client Software connection to the WebCUR Server. You 
will need to purchase the same number of CALs as concurrent Client Software connections to WebCUR. 
Med-Media grants to you the following non-exclusive rights to the Client Software and accompanying 
documentation (collectively called the "SOFTWARE") 
 
Installation, Use and Transfer of Client Software: You may install and use the Client Software on up to 
three (3) licensee-owned client devices per CAL. Concurrent connections to the WebCUR Server are 
ONLY equal to the number of CALs purchased and not the number of Client Software installations. A 
licensee-owned client device is defined as being solely owned by the licensee and housed in the same 
physical location of the other client devices installation under that CAL. 
 
Other Notice to Users - You shall inform all users of the SOFTWARE of the terms and conditions of this 
AGREEMENT. Not For Resale Software - If this SOFTWARE is labeled "Not For Resale" or "NFR," your 
license only permits use for demonstration, test or evaluation purposes. 
 
Authorized Number of Users and Use: In exchange for, and conditioned upon payment of the service 
and annual CAL fees you have committed to pay pursuant to a separate agreement or purchase order, 
you are granted the right and license to use each Software on a single central processing unit ("CPU"), 
except that the Software may be executed from a common disk shared by multiple CPUs provided that 
one authorized copy of the Software has been licensed from Med-Media for each CPU executing the 
Software. You must purchase one CAL for every one thousand (1000) event records submitted to the 
Server and/or installation on any client device not adhering to the above rules under Installation, Use and 
Transfer of Client Software. You may have as many concurrent Client Software connections to the 
Server as you have CALs. Should you not maintain a service agreement and allow your CALs to become 
inactive than you must cease use of the Client Software. Discontinuation of a service agreement will also 
cease the access to the Sever via web browser. 
Upon cancellation of your CAL and Service Agreement you may request delivery of your data in a Med- 
Media determined machine-readable format. This request must be made within thirty (30) days of 
cancellation and you must provide payment for shipping, handling and media costs. 
 
Permitted Use. The Software may be used only in connection with your business (i.e. may not be used to 
offer services for remuneration to third parties) and may not be used for any other purpose. Any other use 
is unauthorized and constitutes a breach of this Agreement. 
 
Support and Maintenance: Med-Media offers technical support and software updates as part of the 
Service Agreement and annual CAL renewal. Failure to maintain one or both of these subscriptions will 
cease the provision of these items. Med-Media reserves the right to determine the best means of 
technical support delivery for you and to provide that support during published business hours. Failure to 
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comply with the support provided by Med-Media may result in termination of this and other agreements. 
Med-Media reserves the right to terminate support for clients who fail to maintain hardware and or to keep 
operating systems current and updated with OEM service packs or patches. 
 
Copies: The Software may not be duplicated or copied except for archive purposes, program error 
verification, or to replace defective media, and all copies made must bear the copyright notices contained 
in the original. You shall not modify, adapt, translate, create derivative works, disassemble, decompile or 
otherwise reverse engineer the Software. You agree that you will not export or re-export, whether directly 
or indirectly, the Software, or any direct products thereof, outside the United States without first obtaining 
the appropriate government approvals. 
 
Transferability: This license and the Software may not be transferred to a third party. Any attempted 
transfer shall render the transfer null and void and of no further effect whatsoever and the transferee shall 
obtain no license to use the Software and use of the Software by any purported assignee shall constitute 
a breach of this Agreement. 
 
Ownership. Purchase of this license does not transfer any right, title or interest in the Software to you. All 
right, title and interest is retained by Med-Media. You are on notice that the Software is protected under 
the copyright laws. The owner of the copyright is Med-Media or its suppliers, as the case may be. 
 
Term and Termination of License: Med-Media reserves the right to terminate this license upon breach 
or alleged breach of this Agreement; provided that such allegation is made in good faith and in the 
reasonable discretion of Med-Media. Terms are also based on acceptance of the terms of annual CALs 
upon renewal. Those terms may supersede areas in this agreement. 
 
Modifications and Additions: You may not modify the Software or includes it in any other software 
program 
 
Use of Software Product for High Risk Activities: The Software is not fault-tolerant and is not 
designed, manufactured or intended for use in conjunction with on-line control equipment in hazardous 
environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft 
navigation or communication systems, air traffic control, direct life support machines, or weapons systems 
("High Risk Activities") in which the failure of the Software could lead directly to death, personal injury, or 
severe physical or environmental damage. Med-Media specifically disclaims any express or implied 
warranty of fitness for High Risk Activities. 
 
U.S. Government Restricted Rights: The Software and documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to 
the Federal Acquisition Regulations ("FAR") in paragraph 252.227- 7013(c)(1) if the 
Software is supplied to the Department of Defense ("DOD"), or subject to Federal 
Acquisition Regulations ("FAR") in paragraph 52.227-19(c)(2) if supplied to any other 
unit or agency of the U.S. Government. 
 
Audit, Testing and Research Rights. Client records shall be maintained in accordance with the Privacy 
Act of 1974 (Public Law 93-579), Freedom of Information Act, and the Health Insurance Portability and 
Accountability Act of 1996(HIPAA). In accordance to the aforementioned acts, Med-Media reserves the 
right to, at any time pursuant of the Service Agreement and CAL purchase, to audit your submitted 
records and to conduct testing on those records to improve the Software. You have provided Med-Media 
a perpetual right to use non-protected health information for research, homeland surveillance and without 
restriction or limitation upon other use. 
 
Prior Agreements. This Agreement is the complete and exclusive agreement between you and Med- 
Media relating to the Software and supersedes any proposal or prior agreement, oral or written, and any 
other communications relating to the subject mater of this Agreement. No variation of the terms of this 
Agreement or any different terms will be enforceable against Med-Media unless Med-Media gives its 
express consent, including and express waiver of the terms of this Agreement, in writing signed by an 
officer of Med-Media. 
 
Warranty of Software: Med-Media represents and warrants that it has full ownership right of (or the right 
to license) the Software, free of all liens and encumbrances and that it has full authority to grant the 
licenses to the Software as contemplated by this Agreement. Med-Media warrants for a period of NINETY 
(90) DAYS from the date of the purchase that the Software will execute its programming instructions 
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when properly installed on the personal computer or workstation indicated on this package. Med-Media 
does not warrant that the operation of the Software will be uninterrupted or error free nor that it fully 
conforms to any specifications therefore. In the event that this Software fails to execute its programming 
instructions during the warranty period, your sole and exclusive remedy shall be to return the diskette(s) 
or tape cartridge(s) ("media") to Med-Media for replacement. Should Med-Media be unable to replace the 
media within a reasonable amount of time, your alternate remedy shall be a refund of the purchase price 
upon return of the Software and all copies thereof. 
 
Limited Warranty of Media: Med-Media warrants the media upon which this product is recorded to be 
free from defects in materials and workmanship under normal use for a period of NINETY (90) DAYS from 
the date of purchase. In the event any media prove to be defective during the warranty period, your sole 
and exclusive remedy shall be to return media to Med-Media for replacement. Should Med-Media be 
unable to replace media within a reasonable amount of time, your alternate remedy shall be a refund of 
the purchase price upon return of the product and all copies. 
 
Notice of Warranty Claims: You must notify Med-Media in writing of any warranty claim not later than 
thirty (30) days after the expiration of the warranty period. 
 
Limitation of Warranty: Notwithstanding anything to the contrary contained herein, Med-Media makes 
no other express warranty, whether written or oral with respect to this product. ANY IMPLIED 
WARRANTY OF MERCHANTABILITY OR FITNESS IS HEREBY DISCLAIMED. 
 
Exclusive Remedies. The remedies provided above are your sole and exclusive remedies. 
YOU ACKNOWLEDGE THAT IN NO EVENT SHALL MED-MEDIA BE LIABLE TO YOU, YOUR 
EMPLOYEES OR ANY THIRD PARTY FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR 
CONSEQUENTIAL DAMAGE OR LOSS OF ANY NATURE (INCLUDING LOSS OF PROFITS) 
WHETHER BASED ON WARRANTY, CONTRACT, TORT, OR ANY OTHER LEGAL THEORY, EVEN 
IF MED-MEDIA HAS BEEN NOTIFIED OF THE POSSIBILITY OR LIKELIHOOD OF SUCH DAMAGES 
OR LOSS. ANY LIABILITY OF MED-MEDIA UNDER THIS AGREEMENT SHALL BE LIMITED TO THE 
AMOUNT OF INITIAL SERVICE/LICENSE FEES THERETOFORE PAID TO MED-MEDIA FROM YOU. 
 
Non-Competition. You shall not use the Software to offer services for remuneration to any other party. 
Any such use shall automatically constitute a revocation of the license granted herein. 
This AGREEMENT will be governed by the laws of the Commonwealth of Pennsylvania, without 
reference to conflict of laws principles. In any dispute arising out of this AGREEMENT, you and Med- 
Media each consent to the exclusive personal jurisdiction and venue in the State and Federal courts 
within Dauphin County, Pennsylvania. 
Notices. Any notice given under this Agreement shall be given to the following: 
Med-Media, Inc. 
6301 Grayson Road 
MS 113 
Harrisburg, PA 17111 
Attn: Customer Service 
 
General. 
A. This Agreement may be amended or provisions waived only by another writing signed by an 
authorized representative of each of the parties. 
B. If Med-Media fails to enforce any term or condition of this Agreement on one occasion, such 
failure to enforce on that one occasion shall not prevent enforcement on any other occasion. 
C. All rights and remedies conferred by this Agreement or by law are cumulative and may be 
exercised singularly or concurrently. 
D. If any provision of this Agreement is held invalid by any law or regulation of any government or by 
any court, such invalidity shall not affect the enforceability of other provisions herein. 
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